
TQ Analyst Example Methods
The TQ Analyst software includes an example method for the following analysis types. These 
tutorials concentrate on the TQ Analyst features which are specific to each analysis type. To learn 
howto use TQ Analyst in general, run the tutorial called Getting Started with TQ Analyst.

Choose an example method by clicking its name below.

 • Simple Beer's Law

 • *CLS using spectral ranges (classical least squares)

 • *PLS (partial least squares)

 • *PCR (principal component regression)

 • Similarity match

 • *Discriminant analysis

 • Search standards

 • Measurement only 'Method type not available in TQ Analyst EZ Edition.

*Method type not available in TQ Analyst EZ Edition.

Simple Beer's Law example method
This tutorial provides two examples of quantitative method development using the Simple Beer’s 
Law analysis in TQ Analyst.

The methods developed in this tutorial are designed to analyze samples which are mixtures of 
iodobenzene, 2,4-lutidine. and dibutyl oxalate.

The first method will analyze for one of the components in the mixture. The second method will 
analyze for all three components at the same time.
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Beer's Law

As mentioned in TQ Analyst Principles, the relationship between infrared absorbance and 
concentration is represented as:

A = ab C
 
Where
 
    A = measured absorbance (peak area or peak height) of an analyte 
band.
 
    a = absorptivity (a property of the material which describes how 
readily the compound absorbs infrared radiation at a specific wavelength)
 
    b = pathlength
 
    C = concentration
 

Beer’s law states that there is a linear relationship between the measured absorbance and the 
concentration of the compound of interest and is the simplest form of quantitative analysis.

This analysis technique is useful in quantitative problems where (1) there are relatively few 
components to quantify, (2) there is a clear absorption peak for each component, i.e., there is no 
overlap from absorption bands of any other components in the sample, and (3) the absorbance 
measured does not deviate from the linear relationship over the range of concentrations to be 
analyzed.

Open the example method

Open the Simple Beer's Law example method which is included with the TQ Analyst software.

Click the Next button below once the example method is open.

Action: Choose Open Method As from the File menu. Select the file TQX_SBL.QNT located in the 
OMNIC\QUANT\EXAMPLES directory. Click the OK button.
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Save a working copy of the method

First, change the Method Title to something you will recognize later and enter your name in the 
Developer's Name field.

Then save the method with a new filename.

Action: Choose Save Method As from the File menu. Enter a file name. Click the OK button.

Viewing the components

Before beginning method development, it is a good idea to take a look at the spectra of the 
components you will be working with.

This is particularly important for Simple Beer’s Law method types. TQ Analyst requites that 
Simple Beer’s Law methods have a unique absorption band for each component that you want to 
measure.

Spectra of the three pure components are included in the example method so that we can look at 
them.

Action: Click the Standards tab; click the View Standards button.

Adjusting display limits

Adjust the display limits so you can see the differences between components.

 1. Choose the Display Limits command near the bottom of the View menu.

 2. Enter 850 and 450 for the X-axis limits. Click OK.

 3. Press Ctrl+F then Ctrl+W to scale the spectra.

The components

lodobenzene and 2,4-lutidine ate both aromatic compounds but they have different substitution 
patterns on the ring. There is a difference in the position of the C-H out-of- plane deformation 
band in the range of 700- 850 cm-1.
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Although there are differences here, the strong peak at 728 cm-1 for iodobenzene has an 
interfering peak from the lutidine.

Choosing peaks

A better choice of peaks for iodobenzene is the ring deformation peak at 684 cm-1. The meta 
substitution of lutidine does not show this peak. Dibutyl oxalate does not have any peaks here 
either.

Because there is no interference, the 684 cm-1 peak satisfies the Simple Beer's Law 
requirements and should be a good peak to quantify on.

Action: Click the Close button on the toolbar.

Method 1: Single component analysis

This method will analyze just the concentration of the iodobenzene in the mixture. Although all 
three of the components are present in the mixture, we will ignore the presence of the lutidine and 
dibutyl oxalate for now.

Action: Click the Components tab.

The components

The Components table has already been set up for iodobenzene. Because this is a single 
component analysis, there is only a one line entry in the components table.

The analysis limits are set to 8.0 - 30.0%. Although the use of analysis limits is optional, we 
strongly recommend using it for all methods you develop. TQ Analyst uses the analysis limits 
when calculating the Performance Index and for many of the suggest wizards. If you don't enter 
analysis limits, you wont be able to take advantage of these features.

Action: Click the Pathlength tab.

Pathlength treatment

The mixtures being analyzed with this method are all liquids at room temperature. The 
component concentrations are high so sensitivity is not a problem; relatively short pathlengths 
can be used.
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We will use an ATR (attenuated total reflectance) accessory for liquid sampling. This technique 
has the benefit of a very reproducible pathlength from run to run. Although we do not know what 
the pathlength is, we do know that it is constant. Therefore, the Constant pathlength is selected.

Action: Click the Standards tab.

Preparing standards

The next step is to design and prepare the standards which span the concentration range we 
intend to measure.

We could make the assumption that there should be zero absorbance at zero concentration and 
simply measure a single standard at a concentration slightly higher than the expected high limit.

This is not always a wise assumption in condensed phase samples.

The standards

We should have standards with concentrations which bracket both the expected low and high 
limits.

In addition, we should include a few extra standards of intermediate concentration so that we do 
not seriously bias the method on one or two standards.

Remember that you can also use the TQ Analyst Suggest wizard to make suggestions as to 
appropriate concentrations for your standards.

Setting usage

This example already has a set of standards ready for use.

Notice how the expected concentration range of 8.0 - 30.0% is bracketed by standards #4 
(slightly lower) and #3 (slightly higher).

Standards #5 and ft7 have their usage set to Validation. These standards will be used to evaluate 
the calibration results and to calculate the Performance Index. Validation standards are not be 
used to construct the calibration.

Standard spectra

The standards shown in the table were prepared and measured using an ATR accessory. Spectra 
were collected at 4 cm-1 resolution with 100 scans each using the standard OMNIC program.
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The stored spectra files were then opened into TQ Analyst. You can, however, collect standards 
directly from the TQ Analyst program.

Action: Click the Regions tab.

Defining the analytical region

The 684 cm-1 peak has already been selected for the analysis. We normally recommend using 
the area of the peak for good quantitative work. This avoids the potential problem of the analysis 
peak shifting in frequency as a function of concentration. We also recommend using a two point 
baseline in order to correct the peak for any baseline offset.

Action: Click the Edit Regions button.

Region selection

Use the Region Selection window to select the frequency points to use for this peak.

The window automatically displays the 3 standards covering the high, mid, and low concentration 
values. As the same points will be used for all of the standards, it is a good idea to display at least 
the highest and lowest concentration standards.

Adjusting region boundaries

Using the Region tool, we will select 699 and 674 cm-1 for the starting and ending points for the 
peak. Click on the left boundary flag and drag it to 699 cm-1. Do the same to set the right 
boundary to 674 cm-1.

In this example, we will have the peak region and baseline limits be identical, although these can 
be set independently. Drag the baseline points to the same location as the peak boundaries.

Action: Click the Close button on the toolbar.

Calibration

We are now ready to calibrate the method. Go ahead and save the changes we made before 
calibrating.

Action: Choose Save Method in the File menu. Click the Calibrate button in the toolbar.
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Calibration results

TQ Analyst now displays the calibration results. The Calculated vs. Actual plot shows a 
comparison of how well the method calculates the component concentration compared to the 
actual concentration in each of the calibration standards (represented by the o symbols). The 
closer each point comes to the straight line, the more accurately the method predicts each 
standard concentration. A table of these values is also presented along with percent differences.

Interpreting the results

The calculations for the validation standards are also presented in the plots and table. The 
validation standards are indicated by the + symbols. These are good indicators of the method 
performance as they are not used in the actual calibration. The method, therefore, is not biased 
towards these points.

As you can see, all of the standards are predicted very nicely by this method.

The performance Index

Another indication of the method performance is the Performance Index (PI).

The PI for each component is displayed in the lower right corner. This index is a numerical 
representation of how well the method predicts the concentration of each component in the 
validation standards. The PI for the whole method (taken over all components) is always 
displayed in the toolbar.

Using the Performance Index

A PI value of 100 indicates that the predicted component concentrations are exactly the same as 
the actual concentrations for all the validation standards. The closer this value is to 100, the better 
the method performance.

A value greater than 95 is considered to be extremely good. This method requires no fine tuning 
and is ready to be used on real samples.

Action: Click the Close button on the toolbar

Three component example

We will now modify the method to quantify all three components in the sample mixture.
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The process is exactly the same as the single component method. The only difference is that our 
tables will have three entries for component information instead of just one.

Action: Click the Components tab.

Adding components

Enter 2,4-Lutidine as the name for the second component; Lut as the abbreviation; and 30 - 40% 
as the analysis range. Note how a new, vacant row is automatically added to the table to let you 
add an additional component.

For component 3, enter Dibutyl oxalate as the name; Oxal as the abbreviation; and 35 - 60% as 
the analysis range.

Action: Click the Standards tab.

Entering component concentrations

Entering component concentiations Enter concentrations for each standard as shown below:

Index Lut Oxal

1 32.6 52.2

2 41.0 35.9

3 26.2 41.1

4 34.1 59.8

5 29.1 51.6

6 38.7 33.5

7 37.0 53.1

8 27.5 61.4
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The concentration values

As mentioned before for iodobenzene, notice how standards #3 and #2 bracket the concentration 
range for lutidine while standards #5 and #3 bracket the oxalate.

Again, you will probably want to use the Suggest Standards wizard to recommend appropriate 
standards when you develop your own methods.

Action: Choose Save Method in the File menu. Click the Regions tab.

One component per region

Note that two new regions have been allocated.

TQ Analyst Simple Beer’s Law methods always use one region for each component. Each of 
these regions must be unique; that is, have no overlap with another region. If your application 
does not meet these requirements, you should use a CLS method type.

Suggest regions

Try using the Suggest Regions wizard to see what regions TQ Analyst recommends for this 
analysis.

Follow the wizard instructions; select the "Replace existing regions" option and the standard 4000 
to 400 cm-1 range.

Action: Click the Suggest Regions button on the Regions tab.

The suggested regions

TQ Analyst has made recommendations for all three components. The Region Selection window 
is displayed so you can take a look at each suggested region.

Don't make any changes to the suggestions right now. Instead, let's calibrate and see how we do 
using the suggested regions.

Action: Click the Close button then the Calibrate button both on the toolbar.

Calibration results

The results for iodobenzene look fine. The performance index of 93.1 is basically unchanged from 
the 93.0 value we got before changing the method to 3 components. Take a look at the results for 
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the next two components. Action: Click the Next button in the Select Component control.

Lutidine and oxalate results

The results for 2,4-lutidine and dibutyl oxalate are equally good. The individual component PI 
values of 97.2 (lutidine) and 97.4 (oxalate) contribute to an overall PI value of 97.6 for the method. 
This cumulative PI is displayed in the toolbar.

Action: Click the Close button on the toolbar.

Can we do better?

Using TQ Analyst’s suggestions, we have managed to put together a good method that will work 
fine for our application.

Let's take a look at the suggested regions and see if there is any room for improvement.

Action: Click the Edit Regions button on the Regions tab.

Iodobenzene suggestion

The region that TQ Analyst suggests for iodobenzene is displayed in the Region Selection 
window. This is a different peak than the one we choose (684 cm-1) for the single component 
method.

Both the suggested 654 cm-1 band and the 684 cm-1 band are due to the same C-H out- of-plane 
deformations. It makes little difference which one we use here; both give equally good results.

Action: Click the Next button in the Select Region control.

2,4-Lutidine suggestion

The selection of the 818 cm-1 band for lutidine is unexpected.

Lutidine has a sharp peak at 1607 cm-1 which is very characteristic of aromatic compounds. 
Fortunately, the same aromatic peak in iodobenzene is significantly lower at 1571 cm-1 and does 
not interfere with the lutidine peak.

Based on out knowledge of chemistry and quant experience, the 1607 peak seems to be a better 
candidate for measuring lutidine.
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TQ Analyst suggestions

TQ Analyst suggestions ate based solely on a statistical analysis of the spectral and 
concentration data present in the standards. These suggestions should be best provided the 
standards accurately represent the samples we will be quantifying with the method.

Nevertheless, let's go with our intuition and change this region.

Changing the region

Follow these steps to see one way to use the Region Selection window features to edit a region.

 1. Click the white area in the X-view control and drag it to the 1650 - 1480 cm-1 range.

 2. Press Ctrl+F then Ctrl+W to scale the display.

 3. Click the display at the 1607 peak to reset the region tool.

 4. Drag the flags at the region boundaries to about 1617 and 1598 cm-1.

 5. Click the Save button to record this change.

Action: Click the Next button in the Select Region control.

Dibutyl oxalate suggestion

The oxalate spectrum clearly shows two carbonyl peaks at 1770 and 1744 cm-1. Although the 
lutidine exhibits combination peaks in this region, they are very small and probably will not hinder 
the method.

TQ Analyst picked just one of these peaks, the one at 1770 cm-1. Go ahead and change the 
region to use both. Set the area boundaries to about 1781 - 1731 cm-1; change the baseline to 
two points at about 1822 and 1693 cm-1.

Action: Click the Close button on the toolbar.

Re-calibration

Notice that the change we made to the regions has caused the method to become uncalibrated. 
We will now re-calibrate it and compare the results with the previous version.

Action: Click the Calibrate button on the toolbar.
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Results of re-calibration

The iodobenzene results are the same as before because we made no changes to this region. 
Notice that the cumulative performance index, in the toolbar, has increased slightly from 97.6 to 
97.9. This is due to the changes in the next two regions.

Action: Click the Next button in the Select Component control.

Lutidine improvement

Lutidine improvement The performance index for 2,4-lutidine increased from 97.2 to 98.4. This is 
not a significant difference but every little bit helps. If nothing else, it confirms that the region 
selection based on our chemical intuition is as good as TQ Analyst’s statistical approach.

Action: Click the Next button in the Select Component control.

Oxalate results

Broadening the region for dibutyl oxalate to include both carbonyl peaks makes no difference to 
the performance for this component.

Action: Click the Close button on the toolbar.

The end

This example has shown you the process to go through when developing a Simple Beer’s Law 
method. The same approach is applicable to the other TQ Analyst method types.

Remember to take advantage of TQ Analyst’s suggest wizards; they can rapidly get you a good 
solution for your problem. You can then spend your time more productively exploring 
modifications which may further improve your results.

CLS Using spectral ranges (Classical Least 

Squares)
Classical least squares (CLS) is an ideal way to measure many gas samples. For this example, 
we have selected a method which is used to monitor methane (CH4) and propane (C3H8) in 

12



automobile exhaust.

Methane and propane in engine exhaust are often emitted at part-per- million (ppm) levels. 
Measuring the levels of these gases provides a lot of information about how the engine and/or 
catalytic converter is working. These levels are also important in evaluating different fuel types 
such as alcohol/gasoline blends.

Both methane and propane absorb strongly in the infrared region around 3000 cm-1, as do many 
other hydrocarbon species. Methane and propane are relatively simple to quantify in the absence 
of other species, but can be more difficult to measure if other gases, such as other hydrocarbons 
or high water levels, are present.

This example will show you how to set up a CLS method to successfully measure methane and 
propane in the presence of other interferences.

Classical least squares

The basic math of CLS, also known as «-matrix, assumes that a spectrum of a mixture is a linear 
combination of each individual compound in the sample. That is, the absorbance bands from 
compound A rise or fall exclusively due to the changes in concentration of A. Thus, the shape of 
compound A's absorbance bands are not affected by the concentrations of compounds B or C. 
This means there are no chemical interactions (solvation effects, band broadening, band shifting) 
between different compounds. This also requires that all components in the mixture be included 
in the calibration.

However, a powerful feature of CLS is the ability to handle spectral interaction in the form of 
overlapping bands from different compounds. Simple Beer’s Law techniques such as Peak 
Height or Peak Area will give erroneous results if the band(s) of interest overlap with bands due to 
other compounds. CLS allows heavily overlapping bands to be used.

Open the example method

Open the CLS example method which is included with the TQ Analyst software.

Click the Next button below once the example method is open.

Action: Choose Open Method As from the File menu. Select the file TQX_CLS.QNT located in 
the OMNIC\QUANT\EXAMPLES\ directory. Click the OK button.
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Save a working copy of the method

We will save this example as a new method so that the changes we make will not overwrite the 
original.

First, change the Method Title to something you will recognize later and enter your name in the 
Developer’s Name field. Then, save the method with a new filename.

Action: Choose Save Method As from the File menu. Enter a file name. Click the OK button.

Method description

All samples were collected at 0.5 cm-1 resolution using a mid-IR source, KBr beamsplitter, and an 
MCT-A detector.

The gas cell was a 10 meter pathlength with KBr windows, heated to 100° C, pressure maintained 
at 650 mmHg (slightly below atmospheric pressure). Gases were collected from pressurized 
cylinders, with a constant flow of about 5 liters/min through transfer lines and sampling manifold 
which were all maintained at 100° C.

Sampling conditions

A long pathlength cell is necessary to detect hydrocarbon species at low ppm levels and is 
recommended for most gas applications. At 10 meters, the absorbance bands of interest were all 
between .05 and .5 ASS, which is an ideal absorbance range for quant.

Higher absorbance levels (> 1 ASS) may affect the linearity of the spectrum, whereas lower 
absorbance levels (<.01 ASS) may cause problems with S/N and detection limits. The gas cell 
was heated to 100° C to prevent problems with condensation of water and other gases which are 
present at high concentrations in auto exhaust. The pressure of 650 mmHg and 5 liter/min flow 
rate are convenient sampling parameters for gases.

Temperature & pressure

The temperature and pressure of a gas must be constant, or at least known, in order to get good 
quant results.
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Rising temperatures cause a gas to expand, whereas rising pressure compresses the gas. 
Changing temperature and pressure will change the gas density, which is defined as # of 
molecules/unit area. This, in turn, changes the effective pathlength of the sample.

Effective pathlength

While the gas cell is fixed at 10 meters, the infrared beam will interact with fewer gas molecules 
within that 10 meters ift he gas is at high temperatures and low pressures. Thus, the absorbance 
values recorded by the detector will be weaker (lower) than those of the same gas sample at a 
lower temperature and higher pressure.

Action: Click the Pathlength tab.

Pathlength treatment

Because we used a constant temperature and pressure gas cell, the pathlength can be treated as 
a Constant in this example.

Action: Click the components tab.

Components

The method is set up for three components: propane (C3H3), methane (CH4), and carbon dioxide 
(C02).

The analysis limits are set to 0 to 150 ppm for propane, 0 to 55 ppm for methane, and 0 to 350 
ppm for C02. Although we are not interested in measuring the C02 concentration, it is included in 
the method because it is present in the samples.

Action: Click the Standards tab.

Standards

The method contains 10 standards; 8 are used for calibration and 2 for validation.

This choice of calibration and validation standards demonstrates good experimental design. The 
calibration standards cover the range from 10 - 49.5 ppm for methane and 2 - 122 ppm for 
propane. The two validation standards lie within the extremes.
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For CLS methods, only one calibration standard per component is required. Using more, as we 
do here, is a good idea but not necessary.

Data collection parameters

Gas spectra generally have sharper absorbance bands than liquid or solid phase samples 
because there are no interactions between the molecules. In particular, small gas molecules with 
only a few atoms (CO, C02, NO, CH4) show an envelope of sharp absorbance bands.

These standards were collected at 0.5 cm-1, which is generally a good trade-off between 
resolution and sensitivity.

Action: Click the Regions tab.

Regions

We have set up this method to measure two regions of the spectrum; one for both propane and 
methane, and a second for C02.

We will use the Region Selection window to examine the regions superimposed on the standard 
spectra.

Action: Click the Edit Regions button.

Region selection window

The Region Selection window is always displayed showing the first region and three spectra. 
These spectra are the standards which represent the high, mid, and low concentration range for 
the components being measured in the region.

Measurement type

CLS works by first calculating the shapes of the absorbance bands for each pure compound in 
the mixture. Then, it fits the shapes of all compounds together in a linear combination which most 
closely fits the sample.
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Simple Beer’s Law methods, on the other hand, measure a peak (or set of peaks) of a given 
compound and determine a single peak height or area value. CLS uses every data point in the 
measurement region for its calculations. It fits n points to the sample instead of only 1 point.

Methane & propane

Both methane and propane absorb strongly in the infrared region around 3000 cm-1, as do many 
other hydrocarbon species. We will use the single region for both components. This region is a 
spectral range from 3125 - 2850 cm-1. At 0.5 cm-1 resolution, this corresponds to roughly 800 
spectral data points.

No baseline treatment is needed for these gas phase spectra.

Action: Click the Next button in the Select Region control.

Carbon dioxide

Although we are not interested in quantifying the C02 level in samples, we include it in the method 
because it is present in the samples. The second region from 2390 to 2290 cm-1 is set up to 
measure the carbon dioxide level in the samples.

Action: Click the Close button on the toolbar.

Calibration

The method is all set to calibrate.

The next couple of frames describe what goes on during the CLS calibration process.

Action: Click the Calibrate button on the toolbar.

CLS Calibration - simplified

A simple way to think of CLS is successive subtractions of each compound in turn. For example, a 
pure spectrum of compound A is compared to the sample mixture and is subtracted until its bands 
are removed (or at least minimized). Then, the same procedure is followed for Compounds B, C, 
and so on until each compound defined in the method is gone. Ideally, each compound will 
subtract out completely and all that is left as a residual is a flat line. In practice, a non-zero 
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residual is left over which includes noise, non-linear bits of compounds that didn't subtract 
cleanly, and potentially the spectrum of other compounds which were not identified in the method. 
The size of this residual is used to calculate how well the calibrated method matrix fits the shape 
of the sample spectrum, and is very useful as a diagnostic tool.

CLS Calibration - in reality

CLS is not actually successive subtractions, but this is an easy way to explain the concept.

Actually, the data points defined in the method for each region are put together into an [s x n] 
matrix, where s is the number of standards and n is the total number of data points contained in 
the regions.

Linear algebra is used to solve for the absorptivity or "K" matrix. This matrix has dimensions [p x 
n] where p is the number of components. This step involves using least squares to minimize the 
residual, which leads to the name CLS.

The K matrix is used to quantify the concentrations for each component in unknown spectra.

Calibration results

The results for the validation samples, + marks in the plot, are good. The calculated 
concentrations for each standard are on the order of± 1 ppm. This indicates that the 3 component 
calibration matrix is a good characterization of the sample.

Action: Click the Close button on the toolbar.

Quantify

Let's quantify a true unknown to see how well the method performs on "real" samples.

We will use one of the sample spectra installed in the same directory as the example methods.

Action: Click the Quantify button on the toolbar. Open the spectrum tqx_cls1.spa located in the
 ...\omnic\quant\examples directory.
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The quantify results

Fitst of all, notice the warnings and low fit values; this sample is very different from the calibration 
model. The standard error of measurement values are also extremely large. So large, in fact, that 
the quantified concentration values should be disregarded.

Action: Click the Close button in the Quantify dialog.

Finding out what went wrong

To understand why the standard errors are so high, we need to look at the residual spectral 
information. The standard error of measurement is calculated from this residual in each region 
where the component is measured.

Action: Choose the Residual Spectra command in the Diagnostic menu. Select the spectrum 
tcfx_cls1.spa.

The residual spectrum

This diagnostic shows the spectral information not accounted for by the calibrated method. In 
other words, the spectral information left over after the unknown has been quantified. The 
unknown spectrum is also shown for comparison.

The residual spectrum is calculated only for the regions set up in the method.

Large CO2 residual

The carbon dioxide region, 2400-2250 cm-1, shows a huge residual caused by a very high level 
of C02 in the sample. The methane and propane region, 3125-2850 cm-1, has a smaller residual 
but does indicate the presence of other contaminants.

Because this method is set up to measure all components in every region, this large C02 residual 
will contribute to the standard error for every component. Leave the Residual Spectrum window 
open and switch back to the method window.

Action: Choose the method window, item 1, from the list of open windows at the bottom of the 
Windows menu.
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Components in regions

We can solve this problem by using the Components in Region table to measure only C02 in one 
region and only methane and propane in the other. Click the cells in the Components in Region 
table so that blue + marks are displayed only for C3H3 and CH4 in region 1 [3125-2850] and C02 
in region 2 [2390-2290],

Go ahead and recalibrate the method after making these changes.

Action: Click the Calibrate button on the Toolbar.

Calibration results

We should not expect to see any differences in the Calibration results, and we dont.

This is because methane and propane do not have any spectral features in the C02 region and 
vice versa. In this case, assigning which components are measured in each region has no effect 
on the quantify results. The only effect is on how the standard error of measurement is allocated 
for each component.

Action: Click the Close button on the Toolbar

Quantify the "real" sample

Now we will quantify the same unknown as before and see how the standard error values have 
changed.

Action: Click the Quantify button on the toolbar and open the spectrum tqx_cls1.spa.

The Quantify results

The standard error for methane and propane are now reasonable. The values accurately 
represent just the error caused by the hydrocarbon contaminants which we saw in the residual 
spectrum.

The high level of C02 still triggers the spectral check warnings the way we want. The error 
attributable to the high C02 level has been localized to the C02 component and no longer 
contributes to the methane and propane errors.
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Poor concentration results

The standard error for methane and propane are small but the predicted concentrations are not 
close to the actual values. For example, the calculated value for propane is 85.03 ± 1.2 ppm but 
the actual value is 63 ppm.

How can this be when the standard error is so small?

Action: Click the Close button in the Quantify dialog.

Set up the display

Please complete the following steps to set up the display for the final part of this example.

 1. Choose Pure Component Spectra from the Diagnostic menu.

 2. Hide the Pathlength spectrum (click the spectrum then choose Hide Spectra in the View 
menu).

 3. Switch to the Residual Spectra window (choose item 2, Residual Spectra, in the Windows 
menu).

 4. Select the residual spectrum and Copy.

 5. Switch back to the Pure Component Spectra window. Paste the residual spectrum.

 6. Choose Display Limits near the bottom of the View menu. Set the X-axis limits from 3150 to 
2550 cm-1. Click OK.

 7. Choose Stack Spectra from the View menu.

 8. Scale the display by choosing Full Scale then Common Scale from the View menu.

Pure components and residual

The pute component spectra show you what the spectrum of each component looks like from the 
calibrated method's point of view.

The residual spectrum shows the information from the unknown sample that the model cannot 
explain. The standard error is calculated from the values in the residual spectrum.

Refer to this display during the following discussion.
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Standard error

The small standard error indicates the calibrated method is doing a good job describing the 
unknown sample. There is a relatively small amount of residual spectrum information which the 
model cannot account for.

Under such circumstances, you would expect the predicted concentration value for each 
component to match the actual values within the standard error limits.

Contamination

The fact that the calculated and actual values do not match is explained by the presence of the 
hydrocarbon contaminants in this sample.

These contaminants have spectral features which are very similar to methane and propane. As 
far as the calibrated method is concerned, these contaminants "look" like methane and propane. 
This is why we see the high predicted concentrations for these components.

The small residual

The residual spectrum, and therefore the standard error, are small for this same reason. The 
model does not see anything particularly abnormal in the unknown sample.

If it were not for the high level of C02 in this sample, the method would not detect anything wrong 
with this sample. The erroneous methane and propane concentrations would be reported and this 
mistake would go undetected.

Include all components

This is a good example of why it is so important to include all components in the calibration set for 
a CLS method.

If you anticipate occasional contamination, you should prepare standards describing the 
contaminants and add them to the calibration set.

22



Overlapping components

When the spectra of the unexpected components overlap the known components, the method will 
fail as it does in this example.

Here, the contaminants overlap the known components so perfectly that there is very little 
residual left unexplained. The small amount of residual leads to a small standard error which is 
not large enough to trigger the warnings we have set for this method.

Action: Click the Close button in the toolbar twice to close both the diagnostic windows. Click No 
to the Save changes prompts.

The end

This example has shown you howto use the Components in Region table to control how each 
region is used in a CLS method.

It has also demonstrated the importance of including all components in the CLS calibration set.

When TQ Analyst suggests regions for a CLS method, it measures all components in every 
region by default. Use your knowledge about the samples you are measuring to guide you in 
correctly setting up the Components in Regions table. Depending on your application, you may 
be able to significantly improve your results.

PLS (partial least squares)
This example method and tutorial demonstrates the PLS (partial least squares) analysis type.

The samples to be analyzed are commercial surfactants used as laundry detergents. The goal is 
a quality control method to monitor the composition of a detergent as it is produced at the plant.

The samples consist of a base surfactant into which 4 additional components are blended. These 
components are glucose, benzoic acid, 1,2-propanediol, and glycerol.

Several of these components have very similar chemical structures. Their spectra exhibit a 
considerable amount of spectral overlap. PLS is a good choice for the method type in this type of 
situation.
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Opening the PLS example method

Open the PLS example method which is included with the TQ Analyst software.

Click the Next button below once the example method is open.

Action: Choose Open Method from the File menu. Select the file TQX_PLS.QNT located in the 
OMNIC\QUANT\EXAMPLES directory. Click the OK button.

Saving a working copy of the method

The example method has component and standards information already entered for you. During 
this tutorial you will set up analysis regions, calibrate the method, and make several other 
changes.

Before getting started, save a copy of the example method so that our changes do not alter the 
original. Do this now by saving the method with a new filename.

Action: Choose Save Method As from the File menu. Enter a file name. Click the OK button.

Changing the method

It is now safe to change the method without worrying about altering the original. As you make 
changes to the method, you should periodically save the method using the Save command in the 
File menu. This will guarantee that the work you have done is saved in case you are interrupted.

Change the method title, and enter your name as the developer.

Now we will step through the method tab by tab to introduce you to the example.

Action: Click the Pathlength tab.

Setting the pathlength

The spectra of all the standards and unknowns we will quantify are collected using a horizontal 
ATR accessory having a ZnSe crystal. This particular accessory has an effective pathlength of 28 
microns.

Because this pathlength will not change as long as we use this accessory, we set the pathlength 
type to Constant.
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If there is a chance we may use a different accessory having a slightly different pathlength, we 
could use the Known pathlength setting. This allows us to use the method the same way (by 
unchecking the Pathlength prompt option) but also gives you the option to change the pathlength 
later should you start quantifying unknowns with a different pathlength accessory.

Action: Click the Components tab.

Examing the components

The Components table shows the name and analysis range for the four components we are going 
to measure. The units are in weight percent with two digits displayed to the right of the decimal. 
Less significant digits are rounded to the closest value.

You would normally enter this information when creating a new method. Because this has already 
been done for you, we will go on to the Standards tab.

Action: Click on the Standards tab.

Picking standards

Selecting a proper set of calibration and validation standards is one of, if not the, key steps in 
creating a successful quant method. We have already done this for you in this example. In real 
life, you would use the Suggest Standards feature or follow the advice in the TQ Analyst 
Principles section of the User's Manual to help you choose.

Examing the standards

For this example, each standard was prepared by spiking a base detergent sample with the 
indicated concentration of each component. All spectra were collected at 4 cm-1 resolution using 
a DTGS detector. The spectral range is 4000 - 700 cm-1; the low end cutoff is due to the ZnSe 
ATR crystal.

There are a total of 28 standards in the method. Of these, 20 are used for calibration and 6 for 
validation. This is a typical number of calibration and validation standards for a four component 
PLS method. 2 standards are set to Ignore. You can use these as "unknowns" and quantify them 
with the completed method.
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Setting up analystical regions

Picking good regions of the spectrum to analyze is the other key to a successful method. We want 
to use only spectral information that changes or correlates with concentration of the components.

We will use the TQ Analyst Suggest Regions feature to do this for us. Because this example 
method does not have any Regions defined yet, the Suggest feature will run automatically when 
you switch to the Regions tab.

Action: Click the Regions tab. Finish the Suggest Regions wizard

Examining the suggested regions

The Suggest Regions wizard recommends using 3 regions. Display the Region Selection task 
window so you can take a look at each suggested region.

Action: Click the Edit Regions button on the Regions tab to display the Region Selection task 
window.

Viewing the first region

When the Region selection window opens it displays three standards representing the low, mid, 
and high concentration ranges for the components.

The first region, 1176.4-977.7 cm-1, looks OK. There is a significant amount of spectral activity 
here. But does this activity correlate to component concentration?

Let's see by looking at the statistical spectra.

Action: Click the Statistical Spectra button:

Examining the multiple correlation spectrum

The display changes to show you seven spectra: multiple correlation, individual component 
correlation, mean, and variance. (Click the Explain button for more information on these).

Looking at the correlation spectra, notice that all four components show very high correlation in 
this region of the spectrum. They all have peaks with a height greater than 0.9. Use the View 
menu to adjust the display.
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Look at the X-view control; it shows the full spectral range of the selected spectrum which is the 
multiple correlation spectrum. The first region is one of the most highly correlating regions in the 
entire spectral range.

Now, follow the steps below to select the Variance spectrum.

Action:

 1. Click the Selection tool.

 2. Click the Variance spectrum trace.

 3. Click the Region tool.

Interpreting the variance spectrum

The variance spectrum shows those portions of the data which have the most spectral activity or 
variance. Peaks in the variance spectrum mean that there is activity; the higher the peak the 
greater the variance. This spectrum does not tell you whether or not this activity is actually related 
to the components you are measuring. For example, the CO2 region near 2400 cm-1 has high 
variance but it is not correlated to component concentration.

Look at the X-view control. The level of activ- ity in this region is high relative to the rest of the 
spectrum. This means we should be able to obtain a good, low noise measurement.

Since we already know the region correlates to component concentrations; it is a good region to 
keep.

Action: Click the Next> button in the Select Region control.

Examining the other regions

Take a look at each of the other regions by clicking the Next> and <Back buttons in the Select 
Region control. Notice how the display limits automatically adjust for each region; this is 
controlled by the Expand Regions option.

Compare each region to the statistical spectra and standard spectra just as we did for Region 1. 
Use the Statistical Spectra and High,Mid,Low Standards buttons in the tool palette to switch the 
display back and forth.

Evaluate each region yourself; think about what you might change but don\ make any changes 
just yet.
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Editing regions

There are no obvious changes that need to be made. We will go ahead and use the regions that 
TQ Analyst has suggested.

The suggested regions have already been added to the method so we do not need to click the 
Save Regions button before closing the Edit Regions window.

Action: Click the Close button. Click the Other tab

Checking other PLS options

The Other tab contains method options specific to each analysis type. This tab shows the options 
which pertain just to PLS methods. Each option has a default value which is a good starting point 
for the method.

This tab is where you control the number of factors to calculate and use for each component in 
the method. Use the Explain button for details on any of these options.

Because this example method has never been calibrated, the Factors Used values are zero. In 
this situation, TQ Analyst will automatically suggest and use factors for each component as part 
of the calibration.

Calibrating

Let's calibrate and see how we do!

Calibration examines the data in the calibration standards, calculates factors for each 
component, and chooses an appropriate number of factors to use for each component. TQ 
Analyst then constructs a model which we will refer to as a "calibrated method". Each of the 
calibration and validation standards is then quantified, or "predicted".

Depending on the type of computer you have calibration may take several minutes - please be 
patient. Closing other Windows applications will free up computer resources. This may speed up 
the calibration.

Action: Click the Calibrate button on the tool bar.
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Interpreting the calibration results

The Calibration Results window displays the calculated results so you can evaluate the method's 
performance.

In the Calculated vs. Actual plot we want to see, ideally, all the data points lie on the diagonal line. 
This would indicate the calculated concentrations are the same as the actual.

This is pretty much the case for the results being displayed for component 1 (glucose). With the 
exception of one or two points, all the standards

Interpreting the % Difference plot

The % Difference plot shows the difference between the calculated concentration minus the 
actual in a little more detail. Small differences will lie close to the horizontal, zero difference, line.

If we look at the % Difference plot, two points clearly show a greater difference (far from the 
horizontal zero difference line). Click the point near the bottom center to identify it in the table.

The bad point corresponds to Standard 9. Note the value for the actual concentration: 1.69. This 
is supposed to be 0.69. A typographical mistake was made when entering the concentration 
values for this standard.

Checking the other components

Click the Next> and <Back buttons in the Select Component control to check the calibration 
results for the other components.

The other components look OK; all the standards lie close to the diagonal in the Calculated vs. 
Actual plot and the calculated concentrations are close to the actual concentrations.

In the % Difference plot, notice that the standards are randomly scattered. This means there are 
no standards having a significantly larger difference than the others. This is what you would 
expect to see for a "normal" result

We will now go back and correct the concentration for glucose in Standard 9.

Action: Click the Close button on the too/bar. Click the Standards tab.
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Editing standards

Locate the bad standard in the Standards table. Its title is PLS Example; Standard 9; Index= 9. 
Click the cell containing the glucose concentration and enter 0.69. Go ahead and save this 
change to the method.

Notice that the calibration indicator in the toolbar changes from Calibrated (green) to Uncalibrated 
(red) when you save the method. Use this indicator to remind you of the current state of the 
method.

Action: Click the Other tab.

Understanding factors

If you are familiar with PLS, you know that choosing the proper number of factors for each 
component is important to the calibra- ted method's ability to predict unknowns.

TQ Analyst contains algorithms which do a good job handling this task for you. The Automatic 
Update option calculates a pool of potential factors (the Number off actors Calculated) and draws 
as many as it needs from this pool. TQ Analyst uses as many factors as necessary to reach a 
minimum in the prediction error curve. 011/e will cover this in more detail in a minute.)

You just need to make sure that the number of factors used is less than the number of factors 
calculated for each component. If these values are the same, it means TQ Analyst used all the 
calculated factors and may need more. In such cases, you should increase the number of factors 
calculated before recalibrating.

Changing the number of factors

In this example, the number of factors used is well below the number calculated for each 
component. It is unlikely that any changes we make to the method will significantly increase the 
number used.

If we reduce the number of factors calculated for each component it will speed up the calibration 
time. Do this now by changing the number calculated to two greater than the number used for 
each component.

Make sure the Auto Update option is selected (checked). While we are changing the method it is 
best to let TQ Analyst re- evaluate the number of factors to use during each calibration.

Action: Choose Save Method from the File menu.
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Recalibrating the method

We will now recalibrate the method to see the effect of correcting the bogus glucose 
concentration in standard #9.

This calibration should also be a little quicker because we reduced the number of factors to 
calculate from 10 to 7 for each component.

Action: Click the Calibrate button on the too/bar.

Evaluating the new calibration

Notice that the Calculated vs. Actual plot for glucose now follows the diagonal and the errors in 
the % Difference plot are much less and more random.

Compare the performance index values for the current calibration with the previous one. You can 
see the performance for glucose is greatly improved. This is also reflected in the higher value for 
the cumulative Pl.

You can take a look at the results for the other components if you wish. They should not have 
changed much; check the Pl values for each component to verify this.

Action: Click the Close button on the tool bar.

Using the advanced PLS diagnostics

Let's explore some of the advanced PLS diagnostics.

The Calibration Results window tells you pretty much all you need to know for this example. With 
real methods, you may want to use some of the other TQ Analyst diagnostics. These diagnostics 
can help you identify and understand other, more subtle, problems with your method.

Action: Choose PRESS in the Diagnostics menu.

Interpreting the diagnostic

Examine the PRESS plots for each component. We want to include only as many factors as 
necessary for the PRESS value to level off. Including too many factors runs the risk of overfilling 
the method. The number of factors we are using for each component seems to make sense.
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It is not clear that we need the sixth factor for the Glucose component. We'll look at the loading 
spectra to help us decide.

Action: Choose Loading Spectra in the Diagnostics menu. Select the glucose component.

Interpreting loading spectra

The loading spectra show you the influence that the spectral data has on each factor for a given 
component. Strong features in the loading spectrum mean that this factor is probably important to 
the model.

Compare the loading spectra for glucose factors 5 and 6. Number 6 is very noisy which indicates 
there is little useful information. We will probably do just fine with 5 factors.

Action: Use the Close button on the too/bar to close both diagnostic windows.

Here are three more things we will try to see if we can further improve the method: a Combine 
regions a Variance scaling a Non-linear PLS After making each change we will recalibrate and 
evaluate the performance index. If it increases we will make the next change; if it goes down, we 
will undo the last change and try the next one.

This iterative approach is typical of how you would create an actual method.

Other things to try

Here are three more things we will try to see if we can further improve the method:

 • Combine regions

 • Variance scaling

 • Non-linear PLS

After making each change we will recalibrate and evaluate the performance index. If it increases 
we will make the next change; if it goes down, we will undo the last change and try the next one.

This iterative approach is typical of how you would create an actual method.

Action: Click the Regions tab.
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Combining regions

Sometimes PLS results improve by using additional spectral data points if they are low in noise.

In this example we will try this by combining our three analytical regions into one. Do this by 
changing the Location values for region 1 to 1735.6 cm-1 and 977.7 cm-1.

Next, delete regions 2 and 3 by selecting the index and choosing the Delete Row command in the 
Edit menu. Save these changes.

Action: Choose Save Method in the File menu.

Calibrating and evaluating the change

Go ahead and calibrate the method to see the effect of combining regions.

When the Calibration Results are displayed, examine the cumulative performance index as well 
as the Pl for each component.

Action: Click the Calibrate button in the too/bar.

Checking the performance index

Notice that the performance index increased slightly. We are going in the right direction. Let's try 
another feature.

Action: Click the Other tab.

Adding variance settings

Select the variance scaling option.

While we're here, check the Number of Factors Used for each component. They have not 
changed. Go ahead and change the Number off actors Used for Glucose to 5 and turn off the 
Auto Update option; this will make the calibration fly.

Action: Click Calibrate in the too/bar.
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Evaluating the effect of variance scaling

Adding variance scaling did not improve the method.

Go ahead and turn off the Variance scaling option so it is not used for the next calibration.

Action: Click the Variance scaling checkbox to turn it off

Allowing non-linear PLS

Finally, we want to try the effect of using non- linear PLS. Selecting this option allows TQ Analyst 
to use a non-linear fit during calibration. In most cases, a non-linear fit is not needed and is not 
used even though this option is selected.

Use the Explain button for a description of the non-linear PLS option.

Action: Clicking the Non-linear PLS checkbox then click the Calibrate button on the too/bar.

Evaluating the option

Using the non-linear PLS option did not change the Pl. This indicates the option is not needed. Go 
ahead and turn off the Non- linear PLS option.

We are pretty much done. Before finishing, we will Quantify one of the standards in our method 
that has been set to Ignore.

Action: Click the Close button on the too/bar. Click the Standards tab.

Quantifying standards

To Quantify a standard in your method, just display its spectrum and click the Quantify button. We 
will do this for Standard if27.

Action: Click the Display button for Standard 27. Click the View Standards button. Click the 
Quantify button on the too/bar.
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The Quantify results

The Quantify dialog shows the results just as they will appear when you run the method from 
OMNIC. For this sample, there are no warnings and the values appear to be reasonable based on 
the low Uncertainty values. The actual values for Standard if27 are as follows:

Component Glucose Benzoic acid Propanediol Glycerol

Concentration 108 1.27 1.67 2.79

Action: Click the Close button in the Quantify dialog.

The end

That's all there is to creating a PLS quantitative analysis method.

Use this same strategy when creating your own methods. Remember to take advantage ofTQ 
Analyst's Suggest wizards to help you get started.

Also, refer to the Explain topics for each item, and especially any diagnostics, to help you 
understand what you are doing.

Action: Click the Close button on the toolbar.

PCR (principle component regression)
The PCR (principal component regression) analysis type is similar to PLS. We will use the same 
example method that we used for the PLS example.

PCR differs from PLS in that spectral data variation is determined independently of the 
component concentration information. Once the spectral variation is determined, it is then 
regressed against concentration in a separate step. PLS carries out these two steps 
simultaneously.

This example method shows you how to set up the PCR method. You can then explore the results 
for yourself.
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Opening the example method

The PCR example method will be generated from the PLS example. Open the PLS example 
method which is included with the TQ Analyst software.

Click the Next button below once the example method is open.

Action: Choose Open Method As from the File menu. Select the file TQX_PLS.QNT located in the 
`OMNIC\QUANT\EXAMPLES directory. Click the OK button.

Saving a working copy of the method

We don't want to overwrite the PLS example method when we convert this to a PCR method. We 
will use the Save As command to create a new copy of the example method so that our changes 
do not alter the original.

Do this now by saving the method with a new filename.

Action: Choose Save Method As from the File menu. Enter a file name. Click the OK button.

Changing the method

It is now safe to change the method without worrying about altering the original. As you make 
changes to the method, you should periodically save the method using the Save command in the 
File menu. This will guarantee that the work you have done is saved in case you are interrupted.

Action: Change Method Title to "PCR Example" and Analysis Type to PCR. Enter your name as 
the developer.

Method differences

The only difference between setting up a PCR and a PLS method is the use of Principal 
components (PCs) rather than factors. This is shown on the Other tab.

But first, we will correct the bad concentration value in this method and set up analysis regions.

Action: Click the Standards tab.
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Fixing the glucose concentration

If you ran the PLS example method, you may remember that this method has an error in the 
glucose concentration value for standard #9. You can go ahead and correct this error now if you 
wish. Change the value for the glucose concentration in standard #9 from 1.69 to 0.69.

Now we will let TQ Analyst suggest analysis regions for us.

Action: Click the Region tab. Finish the Suggest Regions wizard.

Viewing the regions

Display the Region Selection task window to see the suggested regions. These regions will work 
fine as a starting point for your PCR method. Later on, you may want to try editing these regions 
the same way we did for the PLS example.

Action:

 1. Click the Edit Regions button on the Regions tab to display the Region Selection task window.

 2. Click the Close button on the too/bar to close the Region Selection task window.

 3. Click the Other tab.

PCR Other tab

PCR uses a single set of PCs to describe the variance in the spectral data. In contrast, PLS uses 
a separate set of factors to describe the spectral and concentration information for each 
component.

This difference between the two analysis types is shown here on the Other tab. A single value is 
specified for the maximum number of PCs to calculate. In PLS, you would specify a maximum 
number of factors for each component.

Calibration

That is all the changes we are going to make to the method. Go ahead and calibrate it.

TQ Analyst will use as many PCs as it needs (up to the maximum you specified) to span most all 
of the variation in the spectral data.
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Action: Click the Calibrate button in the too/bar.

Calibration results

Examine the calibration results the same way you would in a PLS method.

Notice the additional information regarding the number of PCs actually used for the calibration. 
This information is also added to the Other tab. If the number of PCs used is equal to the 
maximum calculated, you should increase the maximum to make sure the method has enough 
PCs to span the variance.

The end

This is the end of the PCR tutorial.

The best way to get a feel for using PCR vs. PLS is to try the analysis both ways and decide which 
works best for your application.

Similarity Match
This example method and tutorial demonstrates the Similarity match analysis type.

Manufacturing and production facilities and analytical laboratories often find it necessary to 
determine product uniformity or the consistency of incoming materials used in the formulation of a 
product.

In this example, polypropylene stock is being checked against a vendor's standard to ensured 
consistency and purity.

Similarity match is one of the three types of classification methods in TQ Analyst. It is used when 
you want to test unknowns for a single type of material.

Similarity match methods always have just one class. This class is the known material which you 
will be testing for.

You can have as many standards as you need to describe the class. These standards should 
encompass all the variation you would expect to find in the material you are testing. This variation 
can be due to slight changes in the sample composition or in sampling technique.
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For this example, the polypropylene standard was measured four times. Each measurement is 
included as a standard.

Opening the example method

Open the Similarity Match example method which is included with the TQ Analyst software.

Click the Next button below once the example method is open.

Action: Choose Open Method from the File menu. Select the file TQX_SM.QNT located in the 
OMNIC\QUANT\EXAMPLES directory. Click the OK button.

Save a working copy of the method

First, change the Method Title to something you will recognize later and enter your name in the 
Developer's Name field.

Now save the method with a new filename.

Action: Choose Save Method As from the File menu. Enter a file name. Click the OK button. Click 
the Standards tab.

Options for the standards

The first two options let you display the spectrum title, file name, or both for each entry in the 
standards table. The third option lets you restrict the Y-axis range of the spectral data during 
calibration and diagnostics.

This last option acts like a threshold setting. TQ Analyst ignores spectral features above or below 
the limits. This option can greatly increase the accuracy of the Similarity Match because it can be 
set up to exclude totally absorbing data.

Getting started

Before beginning the method development, it is a good idea to take a look at the spectra of the 
standards. This will provide you with a good representation of the polypropylene spectral 
features. It also lets you check reproducibility errors caused by sampling. For example, baseline 
offset and tilt.
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Action: Click the View Standards button.

Viewing the standards

In this example, the polypropylene standard has a totally absorbing C-H stretching region from 
3000 - 2700 cm-1.

If the Y-limits option is not used, the spectral data in the totally absorbing C-H bands will dominate 
the matching algorithm. The contribution of the smaller spectral bands in the fingerprint region 
(1800 - 1000 cm-1), which is the useful information, is minimized.

For this example, we will use the Y-limits option to ignore the data in the totally absorbing bands.

Action: Click the Close button on the too/bar.

Using the Y-limits options

Set the Y-axis limits option to use only the spectral data between O to 1.5 absorbance units.

We recommended using this option when working with data where strong spectral features 
overpower smaller yet more identifying spectral features.

Action: Click the Regions tab then click the Edit Regions button.

Region type

In general, the more spectral information you include in your method, the better the specificity will 
be for classification method types. You should use Spectral Range as the Region Type. Leave 
the Baseline Type set to None unless you have some unique baseline problems.

For Similarity Match, keep in mind that the stronger spectral features will dominate the matching 
algorithm.

Setting the spectral region

We could set up one region to include the full spectrum. Remember, we selected the Y- axis limits 
option on the Standards tab. This option will automatically exclude any spectral data above the 
threshold of 1.5 absorbance units.
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For this example, however, go ahead and set up one region to include just the fingerprint region 
from 1800 - 420 cm-1. This is more typical of what you would do in a real method.

Action: Adjust the region then click the Close button on the too/bar. Click the Other tab.

Choosing the Match type

You can choose to have TQ Analyst report the Similarity Match result as either a similarity or a 
difference. The same match algorithm is used in either case. This option only affects the scaling 
of the reported result.

This example method is set up to report similarity. We would expect a good match to be in the 
upper 90s.

Action: Click the Report tab.

Choosing the Report options

You will want to turn on the Similarity Match Warning. This check will alert the operator when an 
unknown's sample spectrum does not provide a very good match. You can expect to obtain 
match values well in excess of90 for Find similarity or less than 1 for Find residual differences.

Select the Pass/Fail indicator option in the Results section. This adds a column to the Quantify 
result and displays either "Pass" or "Fail". The threshold for this pass/fail test is the threshold 
value entered in the Similarity Match Warning option.

Calibrating and saving the method

You are now ready to calibrate the method and test it with several unknown samples.

Action: Click the Calibrate button on the too/bar. Select Save Method from the File menu.

Testing the method

You can now test the method by quantifying several unknown samples.

Two example sample files are included with the method. Both example spectral files are located 
in the ..\omnic\quant\examples directory.

Action: Click the Quantify button on the toolbar. Select the file tqx_sm1.spa. Click the OK button
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Quantify results for sample 1

Note the warnings in the Quantify dialog for this first sample.

The warnings indicate this unknown does not match the standards very well as evidenced by the 
low match value of 24. This means that this sample is different than the standard material.

A sample which produces a result like this should be considered suspect; it may be the incorrect 
material, contaminated, blended with another polymer, wrong polymeric length, etc.

In a case like this, you should investigate the origin of the sample since it not similar to the 
standards. As it turns out, this sample happens to be ethylene vinyl acrylate - not polypropylene.

Action: Click the Close button in the Quantify dialog.

Sample 2

Now, Quantify the other example spectrum located in the ...\omnic\quant\examples 
directory.

Action: Click the Quantify button on the too/bar. Select the file tqx_sm2.spa. Click the OK button.

Quantify results for sample 2

In this sample's results, the match value of 99 passes the polypropylene similarity match.

A result such as this indicates the spectrum of this unknown looks very much like the material in 
the standards.

Action: Click the Close button in the Quantify dialog.

The end

This example method has shown you how to set up a Similarity Match method for a typical QC 
application.

Action: Click the Close button on the toolbar.
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Discriminant analysis
This example comes from the surfactant industry. The objective is to monitor the reaction of nonyl 
phenol with an epoxide, most commonly ethylene oxide, to form a phenol ethoxylate. The 
performance characteristics of the resulting nonionic surfactant are dramatically affected by 
progressively adding CH2CH20 units to the phenolic OH group.

Traditionally, the approximate number of moles of ethylene oxide (EO) added to the molecule 
during production is monitored by a hydroxyl value. This value is determined by a time 
consuming, wet chemical procedure involving acetylation and titration.

This example demonstrates the classification of the reaction product by the number of moles of 
ethylene oxide added. It can be routinely performed by a safer, faster, and simpler FT-IR 
procedure using the horizontal ATR sampling technique and discriminant analysis.

Discriminant analysis is used to classify unknown samples. It tells you which of several 
predefined classes the unknown is most like.

Generally speaking, discriminant analysis is a better choice than search standards for sorting 
samples into different classes or categories. Discriminant analysis lets you use several spectra to 
describe each class whereas search standards only uses one standard to describe each class. 
This is important if you have variability in the spectra.

This example has 5 predefined classes; one class for each of 4, 6, 8, 10, and 12 number of moles 
of EO added to the base molecule. Each class has two or more standards to describe the 
characteristics of the class.

Opening the example method

Open the discriminant analysis example method which is included with the TQ Analyst software.

Click the Next button below once the example method is open.

Action: Choose Open Method from the File menu. Select the file TQX_DA.QNT located in the 
OMNIC\QUANT\EXAMPLES directory. Click the OK button.

The example method

The example method has class and standards information already entered for you. During this 
tutorial you will set up analysis regions, calibrate the method, and make several other changes.
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Before getting started, we will save a copy of the example method so that our changes do not 
alter the original.

Saving a working copy of the method

First, change the Method Title to something you will recognize later and enter your name in the 
Developer's Name field.

Now save the method with a new filename.

Action: Choose Save Method As from the File menu. Enter a file name. Click the OK button.

Changing the method

It is now safe to change the method without altering the original. As you make changes, you 
should periodically save the method. This will guarantee that the work you have done is saved in 
case you are interrupted.

Now we will step through the method tab-by- tab to introduce you to the example.

Action: Click the Pathlength tab.

Sample pathlength or thickness

The spectra of all the standards and unknowns we will quantify are collected using a horizontal 
ATR accessory having a 45°ZnSe crystal. This type of sampling produces a constant effective 
pathlength as long as the same accessory and sample matrix are used.

Choosing Pathlength type

For this example, the effect of any slight difference in effective pathlength caused by a different 
horizontal ATR accessory will be unimportant.

The other Pathlength options are useful if you are using a sampling technique which produces 
spectral artifacts unrelated to the sample itself. For example, use MSC if there is a changing 
baseline caused by scattering.

Action: Click the Classes tab.
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The Classes tab

This tab tells TQ Analyst how many classes are in the method and lets you give a name to each 
class. A class is a pre-defined category which you set up when creating a discriminant analysis 
method.

Discriminant analysis always has at least 2 classes; the objective is to classify an unknown as 
belonging to one of several possible classes. If you are only interested in the similarity to one 
class, use a Similarity Match method.

This example has 5 classes. The names and abbreviations are shown here.

Action: Click the Standards tab.

The Standards

The Standards tab is where you open or collect the spectra that TQ Analyst uses to model each 
class.

You must know the class which each spectrum represents and assign the spectrum to that class.

This example method has the 16 standard spectra already loaded. The Classes column indicates 
the class to which each standards is assigned. For example, the +4 EO class has two standards, 
#1 and if2, assigned to it; the +6 EO class has four standards.

Standard usage

The standards have been split up into calibration and validation sets as indicated by the Usage 
column.

Only the calibration standards are used to model each class. Validation standards are not used to 
calibrate the method. TQ Analyst uses the validation standards as "unknowns" to gauge how well 
the method performs. This performance is reported in the Performance Index value.

Number of Validation standards

We would like to have at least one validation standard for each class. However, the +4 EO class 
only has two standards which is the minimum needed for calibration. Therefore, we do not have a 
validation standard for this class.
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Action: Click the Regions tab.

Setting up regions

We are now ready to define the spectral features that will be used in the classification.

In general, we want to use as much information as possible for all the classification analysis 
types. As a starting point, always consider using the full spectral range. This is what we will do in 
this example method.

Next, exclude those regions which are either excessively noisy, highly absorbing, or show no 
activity. All of this is easier to do using the Region Selection window.

Action: Click the Edit Regions button.

Examining the spectra

This example has been set up to display one standard from each class (by selecting the display 
options in the table on the Standards tab).

The first thing we notice is the large, totally absorbing bands near 1100 cm-1. This region 
obviously correlates with the amount of ethoxylate added because the intensity increases in each 
class. However, the intensity values may be non-linear because of the high absorbance. This can 
lead to erroneous classification.

We will exclude this region by setting up two regions, one on either side of this band.

Adjusting regions

We will set up regions on either side of the 1100 cm-1 band to exclude the spectral data above 
about 2 absorbance units.

 1. Drag the left edge of the X-view control to 1200cm-1.

 2. Adjust the Y-axis display limits to Full Scale (Ctrl+F) then Common Scale (Ctrl+W).

 3. Click the display to reset the region tool.

 4. Drag the left region boundary flag up to the inflection point at about 1056 cm-1.

 5. Drag the right region boundary flag to the right edge of the display (about 660 cm-1).
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Now add a new region to the method.

Action: Click the Add button in the Edit Regions control.

The added region

A new region has been added to the method. We will set up this region to cover the spectrum on 
the high side of the 1100 cm-1 band.

 1. Choose Display Limits near the bottom of the View menu.

 2. Set the X-axis limits to 1900 and 850 cm-1.

 3. Click the display to reset the region tool.

Adjusting the added region

We aren't going to use any of the large 1100 cm-1 peak because it is so highly absorbing. We will 
also ignore the region above 1800 cm-1 because there isn't much spectral activity past this point.

 1. Drag the right region boundary flag to the base of the large peak; about 1174 cm-1.

 2. Drag the left region boundary flag to about 1800cm-1.

Next, we will create one more region around the 3400 cm-1 peak.

Action: Click the Add button in the Edit Regions control.

Adjusting the display limits

Adjust the display so we can set up the new region.

 1. Choose Display Limits near the bottom of the View menu.

 2. Set the X-axis limits to 3800 and 2000 cm-1. Click the OK button.

 3. Adjust the Y-axis display limits to Full Scale (Ctrl+F) then Common Scale (Ctrl+VV).

Setting up region 3

We will set up this region for the bands near 3300 cm-1.
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 1. Click the display to reset the Region tool.

 2. Drag the right region boundary flag to about 2600 cm-1.

 3. Drag the left region boundary flag to about 3700 cm-1.

 4. Click the Close button in the toolbar.

Closing the Region Selection window will automatically save the changes we have made to each 
region.

Saving the method

We have put a fair amount of thought into setting up our regions. This is a good time to save the 
method before going on to look at the Other and Report options.

Action: Choose Save Method from the File menu. Click the Other tab.

The "Other" tab

The Other tab contains method options specific to each analysis type. This tab shows the options 
which pertain just to discriminant analysis methods. Each option has a default value which is a 
good starting point for the method.

Use the Explain feature to tell you more about each of these options and when to use them.

For now, we will just use the default settings for all the options.

Action: Click the Report tab.

Checking the report system

The Report tab options let you control what information is displayed in the Quantify results dialog. 
You can also select which data checks you want TQ Analyst to perform on the unknown sample 
being quantified.

For this example, we will change just two of the option settings so that we can demonstrate these 
TQ Analyst features.

In the Spectrum Warnings section, change the Full spectrum check threshold from the default 
value of95 to 97.
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In the Classification Warnings section, select the Distance value check.

Action: Choose Save Method from the File menu.

Calibrating the method

We are now ready to calibrate the method and evaluate its performance.

Action: Click the Calibrate button on the too/bar.

Evaluating the calibration results

The Calibration Results window helps you evaluate how well your method performs.

Use the plot to see how well separated each class is from one another. Check for overlap 
between classes. Also check that the standards assigned to each class fall within the statistical 
class boundaries. Use the Explain feature to help you understand how to interpret the plot.

The readouts indicate that one standard has been misclassified. Look at the table; standard #13 
is assigned to class +12 EO but is classified as being in class +4 EO. Click this standard in the 
table. In the plot, this standard appears as a red circle among the squares in the upper left.

Evaluating the misclassification

Use the Select Y-Axis control to display class +4 EO on the X-axis vs. class +12 EO on the Y-axis.

Notice that standard #13, the red triangle, is well to the left of the statistical class boundary for 
class +4 EO (the vertical line). This means that standard #13 clearly belongs in class +4 EO.

Action: Click Close on the too/bar. Click the Standards tab.

Fixing standard #13

Let's take a look at standard #13 to see if we can see why it is misclassified.

Click the Display button for standard #13 so that it will be displayed when we view standards. We 
already have one standard from each class selected for viewing. This will allow us to compare 
standard #13 to each class.

Action: Click the View Standards button.
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Comparing standard spectra

Use the title control in the View Standards window to select standard #13. It now becomes the 
selected (red) trace.

With so many spectra in the window it is easier to see which spectra are NOT like standard #13. 
Use the band near 2900 cm-1 to select and hide each spectrum which is different from #13. Use 
the Hide Spectra command in the View menu.

With the other spectra hidden, it becomes clear that standard #13 and standard #1 are virtually 
identical. Standard #1 is known to be in class +4 EO.

Action: Click the Close button in the toolbar

Changing usage of standard #13

What we have is a mislabelled standard. We are almost certain that it really is a +4 EO sample. 
We could reassign it to class +4 EO, but to be safe we will just set its Usage to Ignore.

Action: Change the Usage to Ignore for standard #13. Save the method then click the Calibrate 
button.

Evaluating the recalibration

As you would expect, ignoring standard #13 fixed the problem.

The method correctly classified all validation standards. The Performance Index increased from a 
value in the low 70s to the high 90s.

We are now ready to try it out on some real samples.

Action: Click the Close button then the Quantify button; both are on the toolbar. Choose the file 
tqx_da1.spa in the ..\omnic\quant\examples directory. Click the OK button.

Quantifying

The sample spectrum is quantified and the results are displayed in the Quantify dialog.

Notice the warning. This indicates the sample spectrum is significantly different from the standard 
spectra. This may happen if something has gone wrong with the process you are monitoring.
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When you see this warning you should disregard the quantify results and take a closer look at the 
sample spectrum.

Action: Click the Close button in the Quantify dialog. Click the Standards tab.

Checking the bad sample

Let's compare the spectrum of the sample we got the warning on to the standards.

Click the View Standards spectrum to display the standard spectra. Choose Open Spectrum from 
the File menu and select the same sample (tqx_da1.spa).

The sample spectrum contains the same absorption bands as the standards but their relative 
intensities are not like any of the standards. The bands at 2900 cm-1 are also very different. 
Clearly, something is wrong with this sample and we should re-collect it or check out our process.

Action: Click the Close button on the too/bar.

Quantifying a good sample

We will now Quantify the other sample spectrum included with this example to show you what a 
"good" quantify result looks like.

Action: Click the Quantify button on the too/bar. Select the file TQX_DA2.SPA. Click the OK 
button.

This sample is from a batch of nonyl phenol with 10 moles of ethoxide added.

The sample is correctly classified as belonging to the +10 EO class and there are no warnings.

Action: Click the Close button in the Quantify dialog.

The end

This example has shown how you can use discriminant analysis to classify samples based on 
their infrared spectral features. A method such as this would typically be used to test and sort 
incoming materials.

Another common use for discriminant analysis is as a prefilter for quantitative analysis. To do this, 
you would first determine the class of a sample, as we did in this example. Once the class is 
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established, you can then apply a quantitative method specifically optimized for that class of 
material.

Action: Click the Close button on the too/bar to close the method.

Search standards
This example demonstrates the use of a Search Standards analysis type to solve a classification 
problem.

In the polymer industry, quality control labs often find it necessary to determine which type of 
polymer a particular sample is composed of. This is typically done as part of a sorting process.

In this example method, we will use six different types of polymer films: polypropylene, 
polystyrene, nylon 6, polyester PETG, cellulose propionate, and ethylene vinyl acetate.

The six different polymer films will be used as the standards. Each standard will represent a 
different type or class of polymer film.

Because there is only one standard per class and several classes, we will use the Search 
Standards method type as opposed to a Discriminant Analysis or Similarity Match type.

Each standard was pressed into a thin film between 5 and 25 um in thickness prior to FT-IR 
analysis.

Open the example method

Open the Search Standards example method which is included with the TQ Analyst software.

Click the Next button below once the example method is open.

Action: Choose Open Method As from the File menu. Select the file TQX_SS.QNT located in the 
OMNIC\QUANT\EXAMPLES directory. Click the OK button.

Save a working copy of the method

First, change the Method Title to something you will recognize later and enter your name in the 
Developer's Name field.

Now save the method with a new filename.
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Action: Choose Save Method As from the File menu. Enter a file name. Click the OK button.

Displaying spectra

Before beginning the method development, it is a good idea to take a look at the spectra of the 
materials you will be working with.

This example method already has the standards loaded. You can look at their spectra by 
selecting the buttons in the Display column of the Standards table and using the View Standards 
command.

Action: Click the Standards tab. Click the View Standards button

Viewing spectra

This display gives you a good idea of the differences between the spectra of the various classes 
of polymers that you will be working with. Use the commands in the View menu to adjust the 
display if you wish.

Note that the cellulose and polyester spectra have some totally absorbing peaks. We will set up 
our method to exclude these bands.

Action: Click the Close button on the too/bar. Click the Regions tab.

Choosing spectral regions

Generally speaking, the more spectral information you include in your method, the better the 
specificity will be for classification methods types. You should set the Region type to Spectral 
Range and the Baseline Type to None.

For Search Standard methods, you should not include regions where the spectra are totally 
absorbing. This is because the searching algorithms normalize the data when calculating the 
match between the unknown and the standards.

This method has been set up to use the full spectral range. We'll use the Edit Regions button to 
adjust regions graphically.

Action: Click the Edit Regions button.
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Modifying region 1

Change the limits for region 1 to about 3930 - 2550 cm-1.

You can do this by clicking the display and dragging the region boundary flags, or by typing the 
values directly into the table.

Now add a new region.

Action: Click the Add button in the Edit Regions control.

Setting up region 2

We will set up region 2 for the spectral data between the totally absorbing bands.

 1. Set the Region Type to Spectrum Range and the Baseline Type to None

 2. Click the display at about 1500 cm-1

 3. Drag the region boundary flags to about 1690 and 1300 cm-1

Now add one more region.

Action: Click the Add button in the Edit Regions control.

Modifying region 3

Set up region 3 for the data below the totally absorbing bands from about 1010 - 470 cm-1.

You can use the Select Region control to review all the regions before closing the window. The 
changes you make in the Region Selection window are automatically saved when you close the 
window.

Action: Click the Close button on the too/bar. Click the Other tab

Choosing the search algorithm

This tab lets you select the type of search algorithm and the number of matches to report.

Our experiments have shown that the Correlation search algorithm is generally the best choice 
when the signal to noise is relatively low.
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We will report just one match for this example.

Action: Click the Report tab.

Choosing appropriate warnings

You will want to turn on the Full Spectrum and Match Value checks as these will assist in alerting 
the method operator when a particular sample has spectral features outside the measurement 
range or when the unknown's spectrum does not provide a very good match.

In this method, we expect to obtain match values well in excess of90 for all unknowns since the 
standards and samples are pure materials.

Calibrating and saving the method

You are now ready to calibrate the method and test it with several unknown samples.

Action: Click the Calibrate button on the too/bar. Select Save Method from the File menu.

Testing the method

You can now test the method by quantifying several unknown samples. Two example sample 
files are included with the method. We will quantify them one at a time.

Action: Click the Quantify button on the too/bar. Select the file tqx_ss1.spa in the
 ..\omnic\quant\examples directory.

Quantify results for sample 1

Note the warnings for this first test sample in the Quantify dialog. They indicate this un-known 
does not match any of the standards very well as evidenced by the low match val-ue of 69, and low 
full spectrum fit value of 67. This means that for this particular sample, none of the standards 
were good matches.

A sample such as this should be considered suspect; that is, the incorrect material, contaminated, 
blended with another polymer, wrong polymeric length, etc. In a case like this, you would want to 
prepare another sample for verification since the results indicate you do not have one of the 
expected samples.
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As it turns out this sample happens to be a film made from amorphous Nylon 6, not normal Nylon 
6.

Action: Click the Close button in the Quantify dialog.

Quantify sample 2

Now quantify the second example spectrum which is located in the same example directory.

Action: Click the Quantify button on the too/bar. Select the file tqx_ss2.spa.

Quantify results for sample 2

In this sample's results, the match value is above 90 for the ethylene vinyl acetate search hit. This 
result indicates the spectrum of sample 2 looks mostly like the ethylene vinyl acetate material.

However, note the warning regarding the full spectrum fit value. This warning resulted from the 
full spectrum check value of83 being below the threshold of95. This warning indicates the 
unknown spectrum contains significant spectral features that are not included in the spectra of 
any of the standards. This spectrum check is based on the full spectrum range (4000 - 400 cm-1) 
not just the measurement regions.

Such a result could indicate a serious contamination. Again, a sample such as this should be 
considered suspect (incorrect material, contaminated, etc.) and its production process should be 
rechecked.

The end

This example method has shown how you can use the Search Standards method type to classify 
or filter unknown samples.

Action: Click the Close button on the too/bar.

Measurement only
This example method and tutorial demonstrate three of the uses of the Measurement Only 
analysis type. These include:
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 1. Reporting the area of a component peak for acceptance levels

 2. Applying a correction to peak values if results drift over time

 3. Using peak area ratios for the level of one component as a percentage of another

Spectral measurements

The first example is the reporting of a simple peak area.

In many cases, the level of one component in a sample must be within certain concentration limits 
in order for a product to be acceptable. These tests are used by both the product manufacturer 
and the end user of the product alike. This can be determined by measuring a component peak 
area and comparing it to the acceptable concentration area limits.

This example is the analysis of the level of iodobenzene in a three component mixture. The level 
must be between 14% and 16% in order for this product to be acceptable.

Open the example method

Open the Measurement Only example method which is included with the TQ Analyst software.

Click the Next button below once the example method is open.

Action: Choose Open Method As from the File menu. Select the file TQX_MO.QNT located in the 
OMNIC\QUANT\EXAMPLES directory. Click the OK button.

Save a working copy of the method

First, change the Method Title to something you will recognize later and enter your name in the 
Developer's Name field.

Now save the method with a new filename.

Action: Choose Save Method As from the File menu. Enter a file name. Click the OK button.

Pathlength option

The measurements were made by the horizontal ATR technique so that the pathlength of each 
sample is assumed to be constant.
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Action: Click the Pathlength tab. Click the Measurements tab.

Defining measurements

Experimentally it has been determined that the 14% and 16% levels correspond to peak areas of 
approximately 0.44 and 0.50, respectively. We have also selected the option Use acceptance 
limits.

This information is already entered into the Measurements table.

Action: Click the Regions tab.

Region table

The region table shows how the spectrum measurement will be made. The measurement is peak 
area from 689 - 679 cm-1 with a two point baseline. The baseline points are at 699 and 674 cm-1.

Now we can run the analysis on a real mixture and see the results.

Action: Click the Quantify button on the too/bar. Select the file tqx_mo1.spa in the
 ..\omnic\quant\examples directory. Click the OK button.

Quantify results

The generated report shows the area value for this sample is 0.47. This is within acceptance 
limits. A warning message would have been displayed under the Warnings heading if the results 
were either too high or too low.

TQ Analyst allows this type of analysis for up to 50 different peaks.

Action: Click the Close button in the Quantify dialog.

Handling drift

Sometimes the results of peak area or height measurements can change over time; the values 
drift from standard values. For example, drift can be caused by a slight difference in component 
interaction due to formulation or various other product changes.
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Instead of measuring all new samples in order to determine new acceptance limits, the measured 
peak area or height values may be altered by applying either of two types of corrections:

 1. Slope - when the area values are off by some percentage value

 2. Intercept - when the area values are off by a constant value

Example 2

In this next example, we will assume that the reported values are now consistently 2.0% low. 
Thus, the measured values must be multiplied by 1.02 in order to get good values. We 
accomplish this through the Measurements tab.

Action: Click on the Measurements tab.

Adding corrections

Turn on the Linear Correction option in order to see the slope and intercept columns in the 
Measurements table. The Acceptance Limits can remain on.

Enter a value of 1.02 for the slope and leave the intercept at 0.0.

Recalibrate and quantify

You must recalibrate the method so that the changes we have made are used for the next 
Quantify operation.

Action: Click the Calibrate button then the Quantify button both the too/bar. Select the file tqx_
mo1.spa in the ..\omnic\quant\examples directory.

Quantify results

The result of0.48 shows the correction which is now just barely within the acceptance limits.

Note: If the correction is a constant instead of a percentage, the constant value for correction 
would be entered as the intercept value in the Measurements table.

Action: Click the Close button in the Quantify dialog.
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Example 3

The last example shows the use of the peak ratio capabilities. This is useful if the thickness 
(pathlength) of a sample changes and is unknown. If a peak due solely to the matrix can be 
located, the area or height of this peak can be ratioed against the area or height of the analyte 
peak in order to compensate for these changes.

Action: Click on the Pathlength

Peak ratio

In this example, we simply want the ratio of peaks of two different components in order to 
determine the relative amount of one to the other. This involves changing the Pathlength type to 
Peak Ratio.

When this option is selected, a table for defining the denominator peak is displayed.

Action: Change to the Peak Ratio option.

Defining the ratio peak

The component we will be comparing to is the 1600 cm-1 peak of2,4-lutidine. We need to input 
this region information on the region table.

 1. Set the Region Type to Area

 2. Set the Location values to 1622 and 1592 cm-1

 3. Select the Two points Baseline Type

 4. Choose Fixed location as the Baseline Type

 5. Set the baseline points to 1622 and 1592 cm-1

Action: Click on the Measurements tab.

Resetting options

Turn off both the Linear correction and the Acceptance limits options.

We are now ready to see the results.
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Recalibrate and quantify

You must recalibrate the method so that the peak ratio changes we have made are used for the 
next Quantify operation.

Action: Click the Calibrate button on the tool bar. Then click the Quantify button. Select the file 
tqx_mo1.spa in the ..\omnic\quant\examples directory.

Peak ratio results

The result shows the ratio as 0.13. This is the approximate amount of iodobenzene relative to the 
lutidine.

Action: Click the Close button in the Quantify dialog.

The end

These examples have shown you how you can use the linear correction and peak ratio options to 
modify the results reported by Measurement Only type methods.

Note that you could use peak heights rather than peak area measurements in any of these 
examples or in your own Measurement Only methods.

Action: Click the Close button on the toolbar.
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